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Introduction
You can output data from Analysis and Reporting Module to 
Microsoft® Word documents, using template files and bookmarks to 
produce documents formatted however you wish. You design your 
document in Word and save it as a template file, with bookmarks 
located where you want the text or graphics to go; then link these to 
a Word report in the Analysis and Reporting Module.

If you want to output more than one record to a single document, 
you will need to use a special numbering convention in order for this 
to work.

The Analysis and Reporting Module comes bundled with a 
number of pre-defined templates and associated reports which you 
can use as examples.

Note that for output to Microsoft Word documents, Microsoft Word • 
must be installed correctly on your system and be registered (as 
happens normally) as an automation server. Analysis and 
Reporting Module does not do the actual writing of the documents, 
rather it controls Microsoft Word invisibly to do the writing.

Analysis and Reporting Module will generate Microsoft Word 
documents using Microsoft Word 2000 or newer.

This document gives instructions on how to create templates in 
Microsoft Word and add bookmarks to them. Note that Microsoft 
Word 2003 was used for the examples here; other versions of 
Microsoft Word may be slightly different but the principals remain.

You can also create Microsoft Word documents without using 
templates with bookmarks. In this case, only simple tables and 
graphics are created, based on your normal template.

Creating a template (.dot)
When you create a new document using Microsoft Word, the 
settings and properties for this new document are taken from a file 
called “normal.dot”. This file is located in a special place defined by 
Microsoft Word itself.

If you want to customise how your default documents behave, you 
can open this file and modify anything in it – the normal font, the 
paragraph spacing, or anything that you can format in any Microsoft 
Word document. When you save the file (keeping it as a template), it 
will provide your own preferred settings for new documents. 

Further than this, you may create any number of template files 
defining different document formats, such as a standard home 
letter, a business letter, and so on.

To create a new document using a template, you use the File | 
New command in Microsoft Word, which should provide you with a 
list of templates to choose from.

When prompted to save a template by Microsoft Word, it usually 
offers you its standard template folder as a location, but you can 
save templates to anywhere. The only difference is that only 
templates in the standard locations are made available when you 
choose File | New in Microsoft Word.

Note that the only thing which distinguishes a template from a • 
normal Microsoft Word document is the file extension – everything 
else is the same. This means you can make any document into a 
template simply by changing its extension from .doc to .dot!

Note that you must “open” the template in a specific way in order to • 
edit it – if you simply double-click on a template, Microsoft Word 
will assume you are creating a new document based on that 
template; you can tell this has happened because Microsoft Word 
will show the document name as “Document x” rather than use the 
name of the template file opened.

To open a template for editing, right-click on it and choose the Open 
command, instread of the New command.



Checking the Bookmarks control will make all bookmarks visible in 
your document as grey I-beams, as shown here:

This makes it easier to see where you have placed them, although 
there is still room for confusion, as you will see!

Note that the • Bookmark window allows you to view the bookmarks 
in the document sorted by name or location. It is easier to use the 
latter when adding new bookmarks to a template[1]:

Note also that bookmark names must contain no spaces!• 

To add a bookmark, first place the cursor at the position in your 
document where the bookmark is to go. This may be in free text, 
within a text box or in a table.

Choose Insert | Bookmark to make the Bookmark window 
appear, and type in a name for your bookmark.

When you have entered the name, press Enter to add it to the list; 
the Bookmark window will close (rather confusingly, since it gives no 
indication your operation was succesful). A grey I-beam should 
appear in your document at the chosen location.

To confirm the bookmark was entered, choose Insert | Bookmark 
and you should see your new bookmark in the list.

To add further bookmarks, simply repeat the above process, 
remembering to move your insertion point each time to the 
correct location – the bookmark editor window is hopeless at 
showing you where the bookmarks are!

There are three ways to create a template: 

Open an existing template and save it under a new template • 
name.
Copy an existing template and rename it.• 
Create a new document and select templates from the • Save as 
type list box when you save it. 

As already mentioned, it doesn’t matter where you save the 
template; Analysis and Reporting Module comes with a set of pre-
defined templates which are stored in a “Report templates” folder 
within its data folder (“Analysis and Reporting Module data” within 
your standard documents path).

Adding bookmarks
To add a bookmark to a template, choose Insert | Bookmark from 
the menu. This will make the Bookmark window appear[1]:

Before doing any serious bookmark editing, you should make a 
temporary change to your Word set up which will make the whole 
process a lot easier: go to Tools | Options, and check the Bookmarks 
checkbox on the View tab[1]:
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Using your template with Analysis and Reporting 
Module
You can output your data to Microsoft Word documents, using 
template files and bookmarks to produce documents formatted 
however you wish. You design your document in Microsoft Word and 
save it as a template file, with bookmarks located where you want 
the text or graphics to go; then link these to a Word report in 
analyzer support software.

The normal method of generating documents is to output one 
record to one document; however, you can output more than one 
record to a single document. To do this you will need to use a special 
numbering convention in order for this to work.

To generate Microsoft Word documents from your data, choose 
Microsoft Word Report Generator Expert from the Tools menu; this 
will open up the Report Generator for Microsoft Word window which 
will take you through the steps necessary to create the reports. If 
you want to use templates for the documents, you will need to have 
created or modified a Microsoft Word template file (.dot) containing 
one or more bookmarks; it is these bookmarks that the software 
uses to insert text or graphics into your document.

The software comes bundled with a number of pre-defined 
templates and associated reports which you can use as examples.

You can define as many report set ups as you like, and run them 
directly using the Default Word Report and Select Word Report 
options under the Tools menu; you may also delete any reports from 
there.

Note that for output to Word documents, Microsoft Word must be • 
installed correctly on your system and be registered (as happens 
normally) as an automation server. Analysis and Reporting Module 
does not do the actual writing of the documents, rather it controls 
Microsoft Word invisibly to do the writing.

Check-to-conformance reports may also be run into Microsoft Word 
documents. The process is the same but there are special rules 
governing how the data is output.

The Analysis and Reporting Module will generate Microsoft Word 
documents using Microsoft Word 2000 or newer.

Setting up your template report
Using the Report Generator for Microsoft Word window, you can 
create any number of “reports” which define the template, link 
bookmarks in the template to report elements[2] from your data, and 
the name and location of the files created.

The Analysis and Reporting Module provides a number of pre-
defined templates, which will be located in a “Report templates” 
folder within its data folder (“Analysis and Reporting Module data” 
within your standard documents path). You can use and modify 
these, or define new ones; it doesn’t matter where you store these 
templates, as long as you can identify them in the report set up.

When you select a template, SKF Analysis and Reporting Module 
reads it and extracts the list of bookmarks it contains. You can then 
associate any report item you wish to include in the output with 
whichever bookmark is appropriate.

For example, if your template contained a bookmark called 
“GraphPlot” which defined where you wanted the graphical plot to 
go, you would select “Graph” from the report elements list and pick 
the “GraphPlot” bookmark from the bookmark list.

You may also add in as many report items[3] to your report as you 
wish, allowing you to output simple data analysis.

Finally, you can choose the document naming to use – you can 
choose either the record name, a GUID[4] or use a custom name (to 
which is added a number to keep each file unique).

You can also choose which directory to write the files into. This is 
specific per report, allowing you to directly output to different places.

Once this is done, you click on the Next button to run the report; a 
progress bar shows you feedback; and once completed, if there were 
no errors, you can choose to view your documents in Microsoft 
Word.

Pre-defined reports may be run directly using the Default 
Microsoft Word report command, which when placed on a toolbar, 
will include a drop-down list allowing you to run any report directly:

Output of check-to-conformance data
Special rules govern how check-to-conformance results are output 
to Word reports.

Check-to-conformance reports contain two things: the 
conformance check report, which is a table of measurement results 
and status values, and a set of spectral readings.

The conformance check report can provide three output items to 
the document – the results table, the machine graphic and the 
multiple plot of the CSV results. Alternatively, you can choose to 
ignore the conformance check results and simply output the 
individual spectral records like a standard report.

[1] Microsoft Word screen shots reprinted with permission from Microsoft Corporation.
[2] Report elements include the record name, reading date, spectral parameters, notes and graph plot.
[3] Reporting items in analyzer support software text reports and Word reports can include amplitudes at individual signature positions, or peak or RSS within user defi ned bands. 

Each item can also be confi gured to include the ordinate value (time or frequency).
[4] A GUID is a 128-bit Globally Unique Identifi er. When created by your computer system, this value is guaranteed to be unique. GUIDs are numerical but are usually shown in 

the following form: {0F447726-A5E1-4340-AAD7-3BEC78B2CCBD}
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For conformance check reports using a Microsoft Word template, 
three bookmark properties are available for the three output items. 
In addition, the standard report template items can be selected but 
will only operate on the first record taken, including its graph plot.

For non-template reports, the three check-to-conformance items 
are output to a plain table and two stand-alone images. If any 
standard report elements are selected they will be output to the 
single document, in sequence at the end, one per spectrum in the 
check-to-conformance.

Writing multiple records to a single Microsoft Word 
document
Generation of Microsoft Word documents from analyzer support 
application data (for both template/bookmark and non-template 
reports) allows you to output more than one record to a single 
document. This is simpler in non-template reports as each record is 
simply written out to the document in simple tables; for templated 
reports, you have to use a special numbering scheme in order for 
this to work, as described here.

The first thing you have to be aware of is that you have to have 
one or more bookmarks for each record that is going to be output 
from your data structure.

You may only run these multiple-bookmark reports on whole data 
structures. If you run one on a record, you will only get that record 
reported as a single element in the document.

You must define your bookmarks with identical names, all of 
which must end with a number; you must use the same names, with 
different end numbers, for each report parameter.

For example, if you wanted to output three records to a file, and 
include the record name and the graph plot for each, you should 
define six bookmarks in the template like this:

RecordName1
Graph1
RecordName2
Graph2
RecordName3
Graph3

You must only use the first set (those bookmarks ending in ‘1’) 
when you pick the bookmarks in the Fields and Bookmarks tab of 
the Report Generator for Microsoft Word window.

For the example above, you would choose bookmark 
“RecordName1” to receive the record name, and bookmark “Graph1” 
to receive the graph plot. The second record in the data structure 
would then be written to bookmarks “RecordName2” and “Graph2” 
and so on. The application automatically generates these bookmark 
names to receive the output for every record in the chosen data 
structure.

This leads to one final further restriction: you must have at least 
as many sets of numbered bookmarks as records that you wish to 
output, otherwise the file generation will fail.

For additional information on SKF products, contact: 

SKF USA Inc.
5271 Viewridge Court  •  San Diego, California 92123  USA
Telephone: +1 858-496-3400  •  FAX: +1 858-496-3531

Web: www.skf.com/cm
® SKF is a registered trademark of the SKF Group.
 Microsoft is a registered trademark of Microsoft Corporation in the United States and/or other countries.
 All other trademarks are the property of their respective owners.

© SKF Group 2009
The contents of this publication are the copyright of the publisher and may not be reproduced (even extracts) unless prior written 
permission is granted. Every care has been taken to ensure the accuracy of the information contained in this publication but no liability 
can be accepted for any loss or damage whether direct, indirect or consequential arising out of the use of the information contained 
herein. SKF reserves the right to alter any part of this publication without prior notice.

Publication CM3117 EN • February 2009


